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Installation

1. When Il install SpatialXL | do not see the SpatialXL tab
appearing in Excel.
Sometimes the add-in is not activated in Excel. You can turn on
this add-in by going to the File > Options > Add-ins > Manage
Com add-ins > Go

You can then activate the SpatialXL add-in by making sure it is
selected and pressing OK.

If your SpatialXL tab is still not appearing then contact
support@primethought.biz for assistance.

2. When | run the SpatialXL installation, | get an error that
complains about corruption.
This occurs with a slow internet connection and means that
SpatialXL.exe has not downloaded correctly and that the
download is corrupted.

To handle this, you have to simply re-download with a better
connection. Using a program such as Free Download Manager
also assists.

3. The prerequisites to installation from the Microsoft sites
take a very long time to download and install.
This also occurs with a very slow internet connection. You can
look for the prerequisites on the internet and install each
separately, but the best solution is to make sure you have a good
internet connection to do this installation and download with.

Viewing


mailto:support@primethought.biz

1. When | open my workbook my sub- layers are not
appearing under my main layer.
This can be a refresh issue. Clicking in the graphics pane (map
area) and zooming in and out by mouse wheeling in and out will
handle this refresh issue.

This especially tends to happen if there is an error in one of the
layers.

2. | cannot see my data, but the hourglass is gone, so it
seems the data has loaded and there are no errors on
the layer.

Try the following options:

a) You might be looking at a different area, so if you Zoom
Fit on the layer or on all the data, that might bring your
data into view.

Right click | Zoom Fit on specific layer:

Layers 3
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Zoom fit

Remaowve layer

B X

Save 3

Use the Zoom Fit globes to optionally Zoom Fit currently
highlighted layer or all layers:
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b) There are invalid coordinates in your data. This is a very
common reason for data not displaying as expected on
the map. Look in the Long/Lat or X/Y etc. columns of your
data and see that the coordinates are not switched around
or maybe have an incorrect number in them such as from
having a decimal point in the wrong place; all this would
cause your data not to plot correctly. If there are blank
coordinates these also would not plot.

In Excel worksheet:

C D E
CUSTOMER NAME * | LONGITUDE ~ LATITUDE -~
JOES PLACE 28,02779 -26,07409
CALTEX STARMART~ADOLFS 27,99753 -26,09934
SAVE RITE SUPERMARKET 27,954422 -26,060841
KWIKSPAR™ROBINDALE 27,93006 -26,11666
CHECKERS FOURWAYS MALL 27966834 -26,023017
CALTEX"CUMBERLAND MOTCORS 28,00514 -26,05349
CALTEX STARMART™LINKSFIELD 28,07754 -26,08532

In layer data grid:



L 233  Properties

|ﬁ View Data...
= Isolate
E]; Zoom fit
CODE CUSTOMER MAME LOMGITLDE LATITUDE
= aflc = =
39901 TOTAL BOMNIOUR~GOLD... 2796708 -26,06880
39804 THE THROBEBIMNG STRAW. .. 27,899338 -26,04047
39728 LULTRA LIQUORS BLAIRG. .. 28,0024 -26,09306
39672 | JOES PLACE 28,02779 -26,07409
39518 CALTEX STARMART~AD... 27,899758 -26,09934
39500 SAVE RITE SUPERMARKET 27954422 -26,000841
39040 KWIKSPAR ~ROBINDALE 27,99008 -26, 11666

c) The coordinate column header names are incorrect. By
default, our software recognizes the following column
header names for coordinates and will automatically plot
the data from those columns.

e Long, Lat

e X,Y,Z

e Longitude, Latitude

e Geometry (Well Known Text format)

If your coordinate column headers are named anything other
than this, the software will not automatically recognize and
plot the data for you and you would have to either change
the coordinate column header names to one of the above or
alternatively, specify the columns under Geometry Extraction
in the Layer Properties:



Layers

Description

0% X Properties |

M View Data...

=] lsolate

wl .
I_"-Q._l Zoom fit

Layer Properties - Sample Outlets

General

Data

Styling

| Text

| Thematics
Projection
Input Transform
Ewvent Scripts
Editing

All Properties

Colour Palette

Layer type: Microsoft Excel 2007/10/13/16

Settings

Range:

Sample Cutlets!A:AE

@ Autoload [ Fit on Autoload [_] Dynamic Load

Connections | Choosepredefined connectionsettings:

Cancel

[ Geometry Bxtraction ]




Geometry Creation Columns n
Geometry Creation:  Point e
Points
* Column: |>{ e |
Y Column: |Y w |
Z Column: |Z e |

d) You might not have loaded data, the file could be empty
or could be incorrectly loaded.

To explore this option, you can open the data grid to see if
there is any data in it.

Right click on layer | View Data:

Layers FoX%

Description

1243 Properties
|ﬁ View Data...

= Isolate

=1 .
I_'Q_, Zoom fit




e) Your data might be so widely distributed that you cannot
see any of it, because the points etc. might be too small
over the entire area.

In this case you can open your data grid and zoom to one of the
elements in the grid.

That way you can pinpoint where this element is without trying to
see everything at the same time.

Right click on layer | View Data:

o 43 Properties
|ﬁ Wiew Data...

= Isolate
El] Zoom fit

Right click on row | Zoom Selected/Zoom and Highlight:

Row Rowl CODE CUSTOMER. MAME
T = = = Aflc
2 2 39901 TOTAL BOMIOUR. -~
r ................. - -
_-_d,l Zoom Selected = Bl
e |
Zoorm and Highlight g

3. The layer is loaded but the little eye next to the layer is
closed.



If you have already set up layers before or are using someone
else's layer, it might be that the data that you want to look at is not
visible at the current display scale.

When you right click on your layer and you select Properties, the
first dialog that you will see is the General Tab.

In here you can set the display from and to scale.

This is very useful to not clutter your map but check it if data is not
visible or even loading at a particular scale!

In the example below, my Retail Outlets are not visible (eye
closed). | access the properties and see that the display from
scale is set to 0 and the display to scale is set to 60 000. My
current view scale is 9,289,773, so | am looking too high for this
layer to load and be visible.

If I change my scale to below 60 000 or zoom into the map, my
data will become visible.

The screenshots below illustrate:



Layer Properties - RetailOutlets >
General Description: |F‘.E13i|Dut|ets |
Data [+] Display Layer (Will render on Map, otherwise just holds data)
Styiing IDispIay from Scale: | UE" tao: | &0,000 Ii" I
Text -
Transparency: - I ) +
Thematics
— [] selectable [#] Snapable [] Editable [»] Includeinlegend [_] Background layer
in
Projection Mnermonic Display
: Change Clear i jon: =
Imput Transfarm Image | = | | | Dimension
Event Scripts
Editing
Colour Palette
[ 0K | | Aeply | | Cancel

Main View =

[xqaoaemaan @ e K|

L... » = X

gadi
1000 T Onlle

\g\%

Description
»{v] Sub_Places.s...

3{V]= % south Africa

3+[ ] © se Bing Satelite
il L% % Google Roads

5 < 0 P
<
) Dragbox to zoom to, or dick to zoomin abit 4 |9,239,773 -}I @ 23.005;-23869 =+ Ty [E @ -90.00,0.00,0.00
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x 0 selected L;:J E Xy

Main View
EEEEEEREXEE IR

= ) A | | Description
L 3 7
b Ld Y

| v @ Sub_Places.s...
3>{v|= W South Africa
i © »¢ Bing Satellite

. ’.:‘,‘—,“( 2 B
3 L.1/] &% ¥ Google Roads
. :

o Stwe
v, TR AR
I';.‘_x——. ~
< i >
. Dragbox to zoom to, or dick to zoomin abit & § 57,575 -\l @ 28035 -26.113 =+ Ty [E @ -90.00,0.00,0.00

4. The data is looking strangely distorted or in the wrong
position.

Check out your map projections.

Sometimes if you are trying to view data from one projection in
another, the data looks distorted or appears in the wrong place.

You can control the scene projection with the black globe icon in
the bottom left of the spatial pane:

e IEUWEL Rancpark|
| Scene Projection WELTEVREDENPARK
[ GCS_WGS_1984
[ Click to change ter Mall . YA
cCv

@ I & |32 - @ 27915 26,127
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You can control the projection for a specific layer by right clicking
on the layer | Properties | Projection:

Layers PoX

Lesaipoon

| Sample Outlets

[v]2 43 Properties
fE View Data...
=] lsolate
Layer Properties - Sample Outlets X
General GCS_WGS_1984 . S B
Data () well known text
ying
Text
Thematics

I Projection

Input Transform

Event Scripts

Editing
All Properties
Predefined layer projections / Use
Mar P ~tane for ailblavere
Manage Projections for sublayers
ur Palet

Note: Whatever the layer projection may be, this gets projected
on the fly to whatever your scene projection is set as.

5. There is ared x next to the layer.

This is an error message.
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Right click on the layer and go to Properties. The error message
will be displayed:

L[] 8 4 3 Properties
Yiew Data...

i
= Isolate

Zoom fit

)

L

¥ Remove layer

Layer Properties - Sub Places.svu *
General Description: Sub Places.svu

Data @ Display Layer (Will render on Map, otherwise just holds data) Reload
Styling Display from Scale: 0 to: & 000 000 000 =

Text Transparency: — [} +

Thematics @ selectable @ Snapable [ Editable (@ Includein legend (] Background layer

Projection [(J Read Only [] Data Read Only

Input Transform | @ Publish @ FublishReadonly (@ Publish Data Readaonly

Event Scripts Mnemonic Display

Editing Image: Change Clear

All Properties Last Errar:

Could not find file 'C-\Users‘\Mark Diamond\OneDrive - Prime Thought Software Solutions CC
‘\Example Workbooks\Sub Places svu’.

Colour Palette

In this example, it cannot find the path of the layer as the original
source file it is referencing was moved.

This is a common error and to fix it you will simply repath to the
correct location by going to the Data tab in the Layer Properties
window, then browse to the correct location using the three little
dots to the right of the file path:
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| Layer Properties - Sub Places.svu >
General
| Data Layertype: SpatialVl File -
|| Styling Settings
|| Text
| ) SWU File Base Folder:
Thematics
| SvU File Path: |Sub Places.svu
| Projection
{ InputTransform |  cojumns: y EE-‘
Ewent Scripts
| Editing
i All Properties Frotection
Optimize SVU File Geometry Extraction
Autoload [ Fit on Autoload [ Dynamic Load
Connections | Choosepredefined connectionsettings R
Colour Palette
| Apply Cancel
______ - _

6. My 3D data is not looking completely 3D, | can see
through objects that are in front or the objects do not
appear in the right order.

This is an issue with the renderer that you are using. Try flipping
to the DirectX renderer.

This renderer is not good for 2D data or big amounts of data and
can give an error on some machines depending on the strength of
the graphics card.

So remember to flip back to GDIPIlus when you don't need to use
the DirectX renderer anymore.

To change renderers, go to Scene Properties:

14



Main View

xR QO &GS W) E e N

/ Scene Properties

i=| Scene properties ™
Display Background Calour: 1 ~|[]Flipcolours sameas background
Projection Show Axes:

Perspective Renderer:

Performance Fill made:

Editing Show Crosshair:

Coordinate Grid | Crosshair colour:

Crosshair radius {(mm):
Scene Tips wmmy:3,0

Legend)Scale Crosshairthickness: 1

Draw time limit (s): 3

[ ] Save for &ll scenes Apply Cancel

Selection

1. When I try to select my data, the mouse does not hook
anything.
This can happen with the GDIPIlus renderer sometimes, because
GDI does not always draw in the true order.

You can try panning back out of the scene a bit.

You can also try putting on the DirectX renderer, but do not use
this option with 2D only data and large amounts of data.

Changing renderers is done in Scene Properties:
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Main View

B EET®EICE N

e S|

Shopping

Scene Properties
hMall o .
= Scene properties e
Display Background Colour: [125... -| []Flipcolours same as background
Projection Show Axes: .~}
Perspective Renderer: GDIFlus
Perfarmance Fill made:
Editing Show Crosshair: Erectﬂa
Coordinate Grid | Crosshair colour: Bl Red -
: e k=
Scene Tips Crosshair radius {mm): (3,0

Legend/Scale Crosshairthickness: 1

LJ

Draw time limit (s):

[] Save for all scenes Apply Cancel

Performance

1. My data loads very slowly or even runs out of memory
when | load.
There can be a few reasons for this, these are the most common
reasons:

a) Large datasets: If you are trying to load a large dataset,
Imagine loading an 8 Gig dataset on a machine that has only 2
Gig memory! (8Gig RAM is the minimum required to use
SpatialXL effectively)

One of the ways of dealing with this is to set your layer properties
to dynamically load the data.

In this way, only the data in the viewing range will be loaded.

16



Set a layer to dynamic load by going to Properties | Data | then

tick on ‘Dynamic Load’ option and set the ‘Max Dynamic

Records’:

Sample Qutlets

Colour Palette

Connections | Choosepredefined connecti

Cancel

L[]8 Y x Properties
M8 View Data...
= I=olate
Layer Properties - Sample Qutlets > X
General
— Layer type: Microsoft Excel 2007/10/13/16 A
Styling Settings entre
Text Range: Sample OutletsIA:AE o
Thematics Geometry Extraction [ 071 |
Projection .
Input Transform
Ewvent Scripts L ]
Editing >
All Properties !J STON
e
[ Autoload [_] Fit on Autoload [ Dynamic Load Max Dynamic Records: 20000 5 )

Only load data for area being viewed dynamically.
Used to browse otherwise too large data sets,

Mote that for database layers the query will need to be constructed appropriately.

Another way of dealing with this is to go to your source data and

split this into smaller bits so that you are for instance only viewing
files much smaller than your memory limitation.

You can also see what type of data you are trying to load. 3D text
elements for instance are very expensive as drawing operations.

You also do not always need to use the 3D text. Export the data

without these elements from the source data.
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b) Wrong renderer: If you are trying to view map data with a
DirectX renderer, instead of GDIPIus, there could be a
performance problem.

DirectX is more 3D orientated and for smaller sets of data.
Flipping your renderer should handle this issue.

Changing renderers is done in Scene Properties:

Main View
xQOo MBS E e K|
s=aliliShopping
Scene Properties |
Mall o .Y

= Scene properties e
Display Background Colour: [125... -| []Flipcolours same as background
Projection Show Axes: .~}
Perspective Renderer: GDIFlus
Perfarmance Fill made:
Editing Show Crosshair: Directx
Coordinate Grid | Crosshair colour: Bl Red -
Scene Tips Crosshair radius {mm): (3,0 =
Legend/Scale Crosshairthickness: 1 2

Draw time limit (s): 3 2

[] Save for all scenes Apply Cancel

c) Mini map: Your mini map is a proper rendition of the scene.
Turning it off can enhance performance.

Turn off the Minimap window in the View tab, under the
Window group:

18
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d) Not much memory: If your PC does not have much memory,

for instance only 1 Gig, and you are trying to look at sizable
files.

Getting a more powerful machine or increasing memory will
help with that. (8Gig RAM is the minimum required to use
SpatialXL effectively)

e) Images: Some image file formats such as Tiffs, JPEGs, and
so forth uses contiguous memory (memory has to be in one
chunk).

This means that even with more memory, images even of 50

MB might load very slowly or you may even run out of
memory.
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This does not occur with Erdas images for example because the
memory handling for these image formats is much better.

A very powerful machine with lots of memory will help.

2. Which layer properties should | set for optimum
loading?

Autoload or dynamic load.

Layer Properties - Sub Places.shp
General
Dats Layer type: ESRI Shapefile v
Styling Settings
Text

Shape File Base Folder:
Thematics
Prajection Shape File Path: C:\Users\MarkDiamondPrimeThought Software Solutions CC\Desiree Diamond
Input Transform | | cqjumns:
Ewvent Scripts
Editing
All Properties

@ Autoload [ Fit on Autoload [_] Dynamic Load

Connections | Choosepredefined connectionsettings i
Colour Palette
Apply Cancel

Autoload: Autoload being turned on will cause SpatialXL to
automatically load the layer data. You can choose between
Autoload and Dynamic Load.

Fit on Autoload: Will cause a zoom fit of the layer data after it’s
been loaded.
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Dynamic Load: In cases where the dataset is very large (such as
SA Road data) this option will load only the portion of data that is
being looked at. This only applies to SQL Server and Shape file
layers. You can choose between Dynamic Load and Autoload.
Please note that Dynamic Load only works for Shape Files and
SVJU files, no other format.

General handling

A general one size fits all handling that can be used for any issue
you may be experiencing with SpatialXL is to hold down the Shift
key when starting the program (before clicking “Show SpatialXL”
and all the while holding it down until SpatialXL has fully loaded);
this will do a software reboot.

Support

T: +27871354351
support@primethought.biz - primethought.biz

mprimeThought Kyalami Estate, Midrand, Johannesburg,

Software Solutions 1684, South Africa

f D &Rt in
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